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A. This document describes how to set up an ESS database when no imagery or GIS-based facility  
data is available.  This  option  has  been a  highly  requested capability  by  multi-service  personnel  
for the  last 9  years.    Despite it being a valuable tool; there  are  some  limitations  that you need to 
be  aware  of  when utilizing  this  particular ESS  option: 

1. Introduction

1. The accuracy will not be as good as if you had obtained quality GIS and RPI data.
2. The accuracy will only be as good as the effort you apply to the process.
3. Probably the most important fact to remember is this process is not even close to the
regular database generation process.  

B. In this process you will be required to gain all of your data and imagery.  You will be 
required to input, classify, and define all of the parameters associated with this option.  
C. Lets briefly review the steps for this ESS option. 

1. Acquire a drawing or image, make a drawing, or obtain a digitally scanned image or
drawing.  
2. Create a new ESS database.
3. Scale the image and add it to the database. Fourth:  Create new GIS layer(s) and then
add the facilities to the database. 

2. Acquire a Drawing or Image

A. Acquire a background image that represents the installation feature. The image can 
be obtained via a number of sources as identified below:

(1) Google Earth: https://www.google.com/earth/
(2) Bing Maps: http://www.bing.com/maps/
(3) Army Mapper: https://mapper.army.mil/

(4) US Army Corp of Engineers, Geospatial Center: http://www.agc.army.mil/
(5) USGS Geospatial Data Sources: http://education.usgs.gov/lessons/
geospatialwebsites.html

NOTE: This site has a very large compilation of sources where you can access free GIS 
imagery.

(6) Your Command GIS POC's
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B. ESS will accept files in the following formats:

C. Below are some examples of images that you can use.  The first image is what this guide 
will be based on for simplistic reasons.

(1) Fort XZY Area:

UNCLASSIFIED
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NOTE: With drawings like this you need to have someone with boots on the ground to gain as 
much information as possible.  The following items as a minimum need to be obtained:

-Facility number

-Size of facilities

-Distances between PES and ESs

-Types of operations performed at each location

-Each HC/D assigned to each facility

-NEW assigned to each facility

-Personnel assigned to each facility

-Critical utilities within the area

-Asset preservation related facilities identified

(2) Hand Drawn:
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(3) Satellite Image:

CAUTION:  Make sure that images obtained while deployed forward are not secret or have 
sensitive data identified.  Coordinate images with the Geo-Spatial Intelligence unit or your 
security manager prior to published use.

UNCLASSIFIED
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3. Create a New ESS Database

A. Launch ESS, go to Start > All Programs > ESS >  Click on ESS

B. ESS is now loaded and the Open Database window will open.
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C. In the Open Database window below, click on the New tab

D. In the Open Database window below, check the Create empty file structure for new 
project box.

E. In the Open Database window below, click the Create New Personal Database button
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F. In the Browse For Folder window select a folder or create a new folder to contain the new 
database.  In this guide, I will use C:\00-ESS\TRNGDB.  (NOTE: This folder location is only for 
the purposes of you following the procedural steps assisting you in the ESS DB development.)

IMPORTANT NOTE: The ESS folder path can only be 256 characters or less.  Any characters 
greater than 256 total will render errors and a lot of headaches for you.

G. In the New Project Name window, enter a name in the 
Enter a name for your new project. 

H. When done, click on OK.
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I. The ESS main screen will open, and the New Database Wizard dialogue will appear 
asking you, Do you want to run the New Database wizard to setup this database?  Click the 
No button.

4. Add and Scale the Image

A.  In the Main ESS Toolbar as seen below; Go to Database Builder > Map Layers >  click on Add 
Background Image
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B.  This will open the Select an image File window as seen below.  If you don’t see your file, you 
may need to change the file type or the folder location. Select the image, then click on Open.

C. A Check Image Scale dialog box as seen below will open letting you know there is no 
scaling information. Click on Yes to launch the Scaling Tool.
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Note: There is additional menu option available allowing you to scale an image.  It is simply a 
different route to access it.  It is located at: Database Builder > Map Layers > Scale Background 
Image. 

D. This will open the Layer Scaling Tool window seen below.  I recommend 
expanding this window to its fullest extent.  You can do this by simply clicking one 
time in the upper right corner on the         .

E. You are required to set two distances: one going North-South and the other going 
East-West.  It is highly recommended that you actually insert more than the two minimal 
distances.  This will increase your accuracy as the program will evaluate all distances you 
input and average them for the scaling.  

F. You will need to find a known distance going East-West. For simplistic reasons, use the 
scale bar found in the bottom right corner of the map. Use the navigation tools to zoom in 
close enough to view the scale bar.  Reference the image on the next page.
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G. Now that you have zeroed in on the tool bar.  Go back to the tool bar at the top of the 
Layer Scaling Tool.  Click on the Measure New Baseline.

H. Take the cursor and click on the 0 end of the scale bar, hold down your left mouse 
button and drag the cursor to the end of the scale in this image which is 900 feet.  You will 
notice that two red X's are at either end of the scale bar as seen in the image below.  You 
will also have an Enter Distance dialogue box come up on the screen.  This Enter distance 
box will appear for each distance you enter.
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I. In the Enter Distance dialogue box below, you will see a box named Enter a Distance for 
this Measurement.  Enter the measurement for your first distance which in this case will be 
900 feet.  Click OK when done.
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NOTE: The 900' was added to the left side of the Layer scaling Tool Window in a box called 
Measured Lines.  You will note the red line created by the program along the top of the scale bar.

J. You will perform steps 5G thru 5I as many times as you feel necessary.  When done click 
the OK button.

TIPs:  
- You need at least one baseline to scale the drawing or image.
- Baselines must be at least 1/2 inch in length when digitized on the screen.  Zoom in on the image 
to digitize lines smaller than 1/2 inch at the current map scale.
- If multiple lines have been digitized, the application will take an average of the measurements 
when deciding upon a scale.
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K. Upon clicking OK you will be returned to the ESS Main screen as seen below.

5. Create a New Map Layer

A. On the ESS Main Tool Bar, go to Tools > Wizards > New Layer Wizard
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B. The New Layer Wizard dialogue will open as seen below.  Click on Next to start…

C. Click on the Select Layer Type button. 
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D. In the Select layer Type window, you can create either a Shapefile, or a Feature Class in a 
Personal Geodatabase, or a Feature Class in a File Geodatabase.  If selecting either the Feature 
Class in a Personal or File Geodatabase, you will need to have an existing Geodatabase . In 
this guide, the New Shapefile in GIS Map Features Folder  is selected.  When done, click 
OK.

E. You have returned to the New Layer Wizard.  Click the Next button as seen below.
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F. The New Layer Wizard has opened up the Enter Layer Name dialogue.  Enter the Layer 
Name of your choice.  For the purposes of this example, I will input PES as the layer name.

G. Click Next.

H. The New Layer Wizard is asking you to Set the layer to be added as either a QD Visible 
Layer or a Background Layer.  If the features on this layer need to be included in the 
analysis, such as an inhabited building or a PES, then select QD Visible Layer.  In this guide, 
we will select  QD Visible Layer, then click on Next.
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I. The New Layer wizard returns and you need to click the Define Structure button in the 
image below.

J. After clicking the Define Structure button above, you will see the New Layer Structure 
dialogue open as seen below.  You have two options at this point: One, choose to copy a 
layer structure from an existing GIS layer; Two,  select a format from a list of SDS Formats. 
In this guide, click the option for Based upon SDS Format, then click on the button, Select 
Format

REFERENCE:  For a listing of layers based on the SDS Format 
see Section 14.

NOTE: SDSFIE = The Spatial Data Standards for Facilities, 
Infrastructure, and Environment (SDSFIE) is the single 
Department of Defense (DoD) spatial standard that supports 
common implementation and maximizes interoperability for 
installation, environment, and civil work missions.
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K. The Table Browser is now open.  To make this easier to read you need to do a couple of 
things:

(1) Take your mouse cursor and place it in the top portion of the Table Browser and 
while holding down your left mouse key pull the Table Browser upward and to the left. 

(2) Click on the Columns drop down menu as seen above.  

(3) In the Table Browser, click on the following column names as seen below--Some 
will already be checked: SDS Type, ID_Field and IS_PES_Table as seen below.  This will 
assist you in seeing exactly what you are choosing.
(4) After selecting the columns you will need to adjust your windows view to see all of 
them.  Simply move your mouse cursor over the left border of the window and it will 
change to this image        and while holding down your left mouse button drag the 
window to the right until you can see the last column.
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(5)  In the Table Browser below, we want to identify the PESs on this image.  You are 
going to click on the row that holds your respective data format.  Since this is PES related 
the SDS format selected can be seen below.  Click OK when done.

NOTES:  In the Table Browser window above, pay close attention to the SDS_TYPE column. 
-For all PESs utilize the following: 

-For all structures other than PESs utilize the following: 

-For all Roadways utilize the following: 

-For all Railways utilize the following:
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6. You are now returned to the New Layer Structure window seen below.  Clicking OK
will return you to the New Layer Wizard seen on bottom right, click Next.

L. The New Layer Wizard has brought up the Create New Layer Dialogue seen below.  Click 
on Next, this will create the blank GIS Layer. 
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A. On your ESS main tool bar use the navigational tools  to zoom-in close on 
the facilities you want to add to the PES layer.  When you select the zoom-in tool and 
move your mouse cursor over the main image it will change to a magnifying glass        .  
Hold down your left mouse key and drag the hour glass cursor to create a box over the 
area you want to work on.  This will enlarge the work area as seen below.

M. You are now returned to the ESS main window and the PES layer is added to the map. 
The PES layer is listed in the left column under Map Layers. That is it; you have created 
the basic shape file for your map.  You now have the task of inputting all of the 
necessary features to support an effective and accurate analysis.

6. Add Facilities to the File Created in Step Five Above
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B. Now that you have your work area zoomed-in as seen above, go to the left side of the 
main window , under Map Layers, click on PES or whatever the name of the layer is your 
going to modify.  If you have multiple layers such as Roads, Railroads, Airfield, PES, 
Structure_Existing, etc...make sure you have selected the right layer. Note the PES is now 
highlighted in blue.
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C. On the ESS Main Tool Bar, click on the green cross, Add Map Feature button in the Editor 
toolbar.

D. The Template Panel will open on the right of the main image.

E. Click on the Template dropdown and select Simple Polygon.

F.  This will open a series of tabs and dialogues you are required to populate with information 
specific to each PES.................................
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G.  In the Template window, make sure the layer you are about to modify is idenitfied in the 
Add to Layer drop down.  If it is blank, click on the Add to Layer drop down and select the 
proper layer.  In this case, I will be using the PES layer.  I do not have any templates to use 
so will use the Mouse clicks for object placement.

H. In the Template window, click on the Features tab, and fill out the Facility number, 
Facility ID and Description, as shown below.  For simplistic reasons I will start with 0001 
and progressively assign numbers for each PES.  The numbers in this example will increase 
progressively regardless of the layer type.  This may not be the case for your installation or 
site, bear this in mind.

VERY IMPORTANT NOTE:  If the Installation, FOB, 
COP or site in general has some form of facility number or 
identification then use those numbers.  If there is any 
questions on the proper numbers to assign to the facilities, 
refer back to our Preparing Data, Folder Structure, Blank  
Database and Performing Data Import guide, page three of 
the Real Property Inventory (RPI) Data section. Be sure 
and add a description as it will be very helpful to 
subsequent users or analysts. 

CAUTION: The ID Seed is in it's simplest form is an 
identity column that creates a numeric sequence for unique 
identification of your data records. The ID Increment is the 

amount that the identity column increases for each new 
row you input.  Do not mess with these two boxes.
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I. In the Template window,  click on the Attributes tab and then click on the Type  Code 
drop down button as seen below.

J. In the Select a Facility Type Code window select the appropriate Type code.  This guide 
will indicate the use of the AGM Type code.  Click OK when done.

NOTE: There are five new drop down boxes that need to be correctly filled in. See next page.
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K. In the Construction Type drop down box select 
Aboveground Site: Light/Open Structure.

L. In the Fragments Contained drop down box select  
No or other type as required.

M. In the Open Location drop down box select Yes.

N. In the Reinforced Openings drop down box select 
No.

O. In the Combustible Construction drop down box 
select No.

P. In the Remote Operation drop down box select 
No.

Q. In the Template window below click on the tab called Missions.

R. In the Template window click on the Category 
Code drop down box and select 42510 for above 
ground magazines.
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S. In the Template window below click on the Explosives tab.

T. In the Template window below click on Add HC/D.
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U. In the Select the Hazard class/divisions to add for this facility window seen below click 
each H C/D required for this facility.   Click OK when done.

V.  In the Template dialogue seen below and under the Quantity column enter your NEW 
quantity.  

NOTE:  At 30,481 lbs of HD 1.1 your blast over pressure distance will become the same or greater 
than your hazardous fragment distance.  

NOTE:  Do not input a hazardous fragment distance 
in the HFD xx: block unless you are dealing with a 
weapon system specifically requiring it.  Refer to DA 
PAM 385-64, Table 8-15.

W.  In the Template dialogue to the left, enter Yes or No in the Fragmenting Item drop 
down.  
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X. In the Template dialogue below, click on the Add button, you will see the cursor 
change to a tiny red star as seen below right.  

Y. Go to the drawing and trace the facility by clicking at each corner, then double-clicking 
on the last corner to finish. The polygon will be added as seen below.
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Z. Repeat steps 6A - Y to add more facilities to the map.  If you have multiple layers such 
as Roads, Railroads, Airfield, PES, Structure_Existing, etc...make sure to make seperate 
shape files, (*.SHP) to make things easier to modify and track.

NOTE: After you have added all the polygons to the map, you need to set the fronts to the 
earth covered magazines and establish your PES and ES relationships. Lets proceed with 
these two processes in the following pages.

Create an ESS DB from an Image
ESS V6.1, B238C

Page 33 of 80



Setting Barricades Utilizing GIS Data or Manually
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Setting Barricades Utilizing GIS Data or Manually

7. Introduction
After the ESS database has been developed and GIS, RPI, and PES data sets have been imported, the 
next step is to setup barricades that exist between PES and ES facilities. If the GIS data contains a layer 
with features representing barricades, ESS can use this GIS layer to automatically detect were 
barricades occur between the PES and ES facilities.  As an alternative, barricades can be manually 
setup without the use of barricades in the GIS data. This first section of this guide describes the 
procedures for using existing GIS data (Shape files or geodatabase) to automatically detect 
barricades between PES and ES facilities. The second section of this guide describes procedures for 
manually setting barricades where necessary.   

A. Refer to DA PAM 385-64, Ammunition and Explosives Safety Standards, 16-25. 
Barricades and Earth Cover for Magazines 

B. REMINDER: Barricades are effective in protecting ammunition or explosives, structures, or 
operations against high-velocity, low-angle fragments although the barricades may be 
destroyed in the process. Since such fragments move along ballistic trajectories rather than 
straight lines, reasonable margins in barricade height and length must be provided beyond 
the minimum dimensions that block lines of sight.  Barricades also provide limited protection 
against blast in the immediate vicinity. They do not protect against high angle fragments and 
are ineffective in reducing the blast pressure in the far field (IBD or PTRD).
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8. Detect Barricades & Perform Spatial Analysis

Note: ESS uses a spatial analysis to detect barricades between PES and ES facilities.  Up to this point in the 
guide, a spatial analysis has not been run.  When we run the Detect Barricades menu option, it will run a 
spatial analysis before going through the procedure of detecting any barricades. 

A. Go to the ESS Main Tool Bar then click on Database Builder > Barricades > Detect Barricades as 
seen in the image below. 

B. On the Detect Barricades window, click on YES to continue: 

Create an ESS DB from an Image 
ESS V6.1, B238C

Page 36 of 80

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle



C. You may get a warning message in the Spatial Analysis Validation Warning window indicating 
there are facilities missing a Type Code, and will automatically assign them the IHB (inhabited 
building) type code. Do not worry about this at this point.  You can review the logs and it will 
identify which facilities were assigned the IHB type code and after the analysis is completed you 
can go back in and change the facilities to the desired type code.  Click on OK to continue: 

D. You will now see a progress window called Analysis.  The Spatial Analysis is in progress.  Be 
patient as this may take a while. (If it is a big base...a long while) As the process is ongoing, it 
will show a status for each task under the status column as seen below.
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E. Upon completion of the analysis you may see this Analysis dialogue box, click OK.

F. When the process is complete, you will see several links to view three different, but 
important logs in the Analysis window.  Any of the rows could have these logs depending on 
errors encountered.

1. Note the Facility Shape Analysis row: There are two logs.  The third log is located in
thebottom left corner of the Analysis window highlighted in blue. Lets review these three 
logs in the pages to follow.
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2. In the Analysis window under the Log column click on the link, View Log. See next page.
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3. You will now see the Facility Shape Analysis 130504237610501663.txt-notepad log
file  below. This file allows you to view which facilities were evaluated for barricades. To 
close this file, click on the X in the upper right corner.
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4. You are now returned to the Analysis window.

5. In the Analysis window above, look at the Errors column and click on the link called
View  Log.  If you have no report in this column then you have done a good job at 
QC'ing your data.
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6. You will now see report name Facility Shape Analysis Errors
130504237610813663.txt-notepad. When done with this report, click the X in the upper 
right corner.

7. You are now returned to the Analysis window seen on the next page.
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8. In the Analysis window below there is one more link to view yet another log.  In the 
bottom left click on the link called Click here to view the log for this process.  This will 
open up the final log as seen on the next page.
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9. In the Analysis window below this log simply provides you a summary of the analysis
run time in hours: minutes: seconds.

10. When done with this report, click the X in the upper right corner of the analysis
window seen above.

11. Upon closing the log
above you are returned 
to the Analysis 
window.  If finished 
click the Done button.
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Note:  Now that the spatial analysis is complete, ESS will proceed with detecting barricades.

G. Upon closing the Analysis window on the previous page you now have the Barricade 
Options window open.   Note: There are two versions you might encounter: The image on 
the left you will encounter when the installation has no Barricade shape file.  In this case, 
you will have to work through the structure_existing_area shape file.   The image on the 
right you will encounter if the installation has an existing Barricade shape file.  

H.  In the Barricade Options window you will select the appropriate file containing your 
shape file for the barricades.  If you are unsure of which file it is, consult with the 
Installation Directorate of  Engineering Division, Master Planner/GIS POC.  

I. In the Barricade Options window  center you 
will see a box called Analyze.  Select the option 
called All Facilities.  Click OK when done.
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J. You will now see the Detect Barricades progress window open.  

K.  Once the detection process is complete you can either view the log or click Done.
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L. This will automatically open the Barricades Detected During Analysis window.  You can 
view the data in this window and export it if necessary.    

M. When done with this report, click the X in the upper right corner.  You are now returned 
to the ESS main window.
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N. If later in your work progression you desire to review this data you can find it in the following 
location:   Main Tool Bar>Database Builder > Barricades > PES ES Barricaded Report. 
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9. Manually Set Barricades

NOTE: If GIS data does not exist for barricades, they can be set manually.  This part of the guide will 
describe the process steps for setting barricades between PES and ES facilities. 

A. Examples of Barricaded Buildings as you will see them in ESS versus other sources:

ESS Image #1 Y-Site: AGM Google Earth Image #1 Y-Site: AGM

ESS Image #2 Production Building: EOL Google Earth ESS Image #2 
Production Building: EOL
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ESS Image #3 ECM: Front Barricade Google Earth Image #3 ECM: frontal Barricade
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B. Use the Zoom In button  to zoom into the area of the map that contains the barricaded 
facilities.  In the example above, PES 11202 has a front, side and rear barricade and the 
surrounding ES's have a front, side and rear barricade. 

NOTE:  If you look at the left side of the ESS main window you will see that no Barricade shape file is 
available.  we are having to utilize the Structure_existing_area shape file for this installation.  Therefore 
we will manually assign the barricades to PES 11202.
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C. In the ESS main window, select the Database Builder > Barricades > Facility Barricading 
menu option. 
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D. The Select a Facility for Barricading window below is now open.  
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E. In the Select a Facility for Barricading window, type in the facility number in the Facility 
Filter box.  To select a specific barricaded facility click one time on the row and it will turn blue 
highlighting the selection.   

F. When selection has been made click OK.

Create an ESS DB from an Image
ESS V6.1, B238C

Page 54 of 80

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle



G. The Facility Barricading window is now open.  

NOTE:  If you refer back to the image associated with step 3B you will see that ECM 11301 is Identified, 
but is not identified in the listing above.  You will manually assign the barricade criteria in the following 
steps.

H. In the Facility Barricading  window, click on Add Facilities and then Selected From Map.
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I. The Facility Selector window is now open.  

NOTE: There is two methods of selecting the facilities you want in this window.  

1. Take your mouse cursor while holding down the left mouse button and drag the cursor around all the
facilities you want to select.  As you drag the cursor you will see an box appear.

2. Take your cursor and select each facility individually by clicking on them.
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J. Upon selecting the facility you will see the facility polygon become highlighted and the facility 
will be added to the bottom window of the Facility Selector.

K. Take your cursor and select the facility.  The selected facility will be highlighted in blue.  Click OK 
when done.  
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L. The Facility Barricading window is now displayed with the ES facility records that were 
selected. 

NOTE:  You will notice there are columns listed for “A Barricaded” and “B Barricaded.” A Barricaded 
refers to the main PES 11202. B Barricaded refers to the ES facilities. If the barricade is part of the main PES 
the A Barricaded column should be checked.  If the barricade is part of the ES,  the B Barricaded column 
should be checked.   Refer to examples provided on the next page.  These are examples of barricading 
scenarios you might encounter.
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Examples of when A Barricade and B Barricade are checked: 

A = 11202 B = 11101

EXAMPLE #1

A = 11202 B = 11102

EXAMPLE #2

A = 11202 B = 11301

EXAMPLE #3
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EXAMPLE #4

A B

EXAMPLE #5

A B

EXAMPLE #6

A B
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M. In the Facility Barricading window go to the Facility No column and click once on Facility 
number 11301.  This will highlight the 11301 record in blue.  Go to the A column and click on the 
check box then go to the B column and click on the check box.

N. Click the OK button when complete.

Create an ESS DB from an Image
ESS V6.1, B238C

Page 61 of 80

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle

Brook.Morris
Rectangle



NOTE:  In the Facility Barricading window you know that everything in either column A or B is 
supposed to be checked.  If you want to verify that, you can right click on the A or B column and 
then choose one of the three options seen below.  When done click on the OK button.

O. Manually setting the barricades is no complete.
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P. To view the barricades report, go to the ESS main tool bar use the Database Builder > 
Barricades > PES ES Barricaded Report menu option.   After clicking on the menu option, be 
patient as it may take awhile depending on the size of your installation. 

Close the report when finished. 

Q. Below is the PES ES Barricaded Report.  You can view all barricaded faciltiies within this 
report and easily export to a number of formats using the Save Report drop down menu.  
When done with the report go to the upper right corner and click on the small X.
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R. To visually see which facilities are barricaded, go to the ESS main tool bar>View > Display > PES 
ES Barricaded menu option.  See the next page.
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S.  In the Select the barricaded PES to display window below, type the facility number in the 
Facility Filter input box. Click the OK button.  You are now returned to the ESS main 
screen.  See the next page.
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T. Lines will be displayed on the screen showing which ES facilities are barricaded for 
PES 11202. To clear the lines,use the ESS Main Tool Bar>View> Display> Reset 
Display menu option. 

This concludes the setting barricades guide.
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10. Introduction to Facility Relationships

After the ESS database has been developed and GIS, RPI, and PES data have been imported, the next step is 
to setup relationships between PES and ES facilities.  This instructional documentation describes the 
procedure for setting facility relationships from PES to ES facilities. This is used when facilities are 
involved in similar mission activities and the types of facilities qualify for reduced quantity distance.   

11. Examples of Facility Relationships:

A. Above ground Magazine to an Inhabited Building (House):  Related or Not Related is the 
question?  In this case, No Relationship exists and requires the maximum QD be applied

B. Explosives Operating Location (EOL) to a Surveillance Workshop: Related or Not Related 
is the question?  In this case, we can establish a relationship and therefore justify the reduced 
QD criteria assigning Intraline (unbarricaded even if HD 1.1 is present at the PES).  
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C. Above Ground Magazine (AGM) to a Public Traffic Route (PTR): Related or Not Related 
is the question?  In this case, there is no relationship and the ES (PTR) is an off base 
highway.  In this case the PES will require the maximum PTR distance from the ES.  

D. Earth Covered Magazine (ECM) to a Earth Covered Magazine (ECM): Related or Not 
Related is the question?  In this case, there is a relationship and therefore you can apply 
the minimum intramagazine distance.  

NOTE:  There are many factors involving these types of PES to ES relationships.  Always 
refer to the latest DA PAM 385-64 for specific criteria.  
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12. Establish Relationships:

A. Go to Database Builder > Related > PES-ES Related:
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B. In the Select Facility to Relate to Others window, Click on the “Select a PES with 
related exposed sites”, then click on the ‘Select Facility Using List’

C. When the Facility Selector window opens, scroll down the list and click on the row 
for the facility you need. This will highlight the row you want to use. Then click on OK.
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D. Another window PES to ES Related will open.  Click on Add Facilities > Select from List pull 
down menu seen below.

E. Facility Selector window is now open.  Your facilities are listed as seen below. Scroll down and look 
for your facility number and click on the row so that it is highlighted, then click the OK button. 

Note: You can select more than one Exposed Site by holding the CTRL key down on your keyboard while 
using your mouse to select multiple rows.
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F. The facility(s) you selected will be added to the list in the PES to ES Related window seen above.  
Next, you will add a relationship type, by clicking on the Relation Type drop down list and 
selecting the appropriate relationship code.  As an example we have selected D – ES and PES are 
parts of the same facility, area, or conveyance and no QD applies . It is important that you click 
on the Apply button for your codes to be changed. 

G. The facility(s) you selected should reflect a Related Code D as seen above.

H. Repeat this step for any additional facilities you need to establish relationships for.

Reference: See Section 13 for a complete listing of Relationship codes with definitions. 
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I. Click on OK, when you finish adding relationships to the facility(s) you selected.

J. After clicking the OK button, you will be returned to the Select Facility to Relate to Others 
window seen below.

K. You also have the option to Select an exposed site related to a PES. The process is 
identical to what you just completed except your looking back from the ES to the PES(s).

ES PES
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L. Close the Select Facility to Relate to Others window when finished by clicking the X in the upper 
right hand corner of the image below.  This will return you to your ESS main window.

Create an ESS DB from an Image
ESS V6.1, B238C

Page 74 of 80

Brook.Morris
Rectangle

Brook.Morris
Rectangle



13. ESS Relationship Codes
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14. SDS Attributes Expected
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SDS Entity Set SDS Entity Class SDS Entity Type Entity Name SDS Attribute ID Number (Link) Desc Attribute Description
buildings buildings_general canopy_pavilion_site bggenstr buildng_id TRUE FALSE FALSE Primary Key
buildings buildings_general canopy_pavilion_site bggenstr facil_no FALSE TRUE FALSE The actual building number on the physical structure (NFADB facno)
buildings buildings_general canopy_pavilion_site bggenstr str_mat_d FALSE FALSE FALSE Construction type of material used
buildings buildings_general canopy_pavilion_site bggenstr str_type_d FALSE FALSE FALSE The type of structure.
buildings buildings_general canopy_pavilion_site bggenstr structname FALSE FALSE TRUE Common name given to the structure.
buildings buildings_general carport_site bggenstr buildng_id TRUE FALSE FALSE Primary Key
buildings buildings_general carport_site bggenstr facil_no FALSE TRUE FALSE The actual building number on the physical structure (NFADB facno)
buildings buildings_general carport_site bggenstr str_mat_d FALSE FALSE FALSE Construction type of material used
buildings buildings_general carport_site bggenstr str_type_d FALSE FALSE FALSE The type of structure.
buildings buildings_general carport_site bggenstr structname FALSE FALSE TRUE Common name given to the structure.
buildings buildings_general shed_site bggenstr buildng_id TRUE FALSE FALSE Primary Key
buildings buildings_general shed_site bggenstr facil_no FALSE TRUE FALSE The actual building number on the physical structure (NFADB facno)
buildings buildings_general shed_site bggenstr str_mat_d FALSE FALSE FALSE Construction type of material used
buildings buildings_general shed_site bggenstr str_type_d FALSE FALSE FALSE The type of structure.
buildings buildings_general shed_site bggenstr structname FALSE FALSE TRUE Common name given to the structure.
buildings buildings_general slab_area bggenfnd struct_id TRUE FALSE FALSE Primary Key
buildings buildings_general slab_area bggenfnd feat_desc FALSE TRUE FALSE A description of the feature.
buildings buildings_general slab_area bggenfnd str_mat_d FALSE FALSE TRUE Construction type of material used
buildings buildings_general structure_existing_site bggenstr buildng_id TRUE FALSE FALSE Primary Key
buildings buildings_general structure_existing_site bggenstr facil_no FALSE TRUE FALSE The actual building number on the physical structure (NFADB facno)
buildings buildings_general structure_existing_site bggenstr no_occup FALSE FALSE FALSE Number of persons currently occupying the building.
buildings buildings_general structure_existing_site bggenstr str_mat_d FALSE FALSE FALSE Construction type of material used
buildings buildings_general structure_existing_site bggenstr str_type_d FALSE FALSE FALSE The type of structure.
buildings buildings_general structure_existing_site bggenstr structname FALSE FALSE TRUE Common name given to the structure.
buildings buildings_general structure_future_site bggenstr buildng_id TRUE FALSE FALSE Primary Key
buildings buildings_general structure_future_site bggenstr facil_no FALSE TRUE FALSE The actual building number on the physical structure (NFADB facno)
buildings buildings_general structure_future_site bggenstr no_occup FALSE FALSE FALSE Number of persons to occupying the building.
buildings buildings_general structure_future_site bggenstr str_mat_d FALSE FALSE FALSE Construction type of material used
buildings buildings_general structure_future_site bggenstr str_type_d FALSE FALSE FALSE The type of structure.
buildings buildings_general structure_future_site bggenstr structname FALSE FALSE TRUE Common name given to the structure.
buildings buildings_general tower_site bggenstr buildng_id TRUE FALSE FALSE Primary Key
buildings buildings_general tower_site bggenstr str_mat_d FALSE FALSE TRUE Construction type of material used
buildings buildings_general tower_site bggenstr structname FALSE TRUE FALSE Common name given to the structure.
buildings buildings_space building_floor_area bgspaflr floor_id TRUE FALSE FALSE Primary Key
buildings buildings_space building_floor_area bgspaflr buildng_id FALSE FALSE FALSE FOREIGN KEY - Links the record to BGGENSTR through primary key buildng_id
buildings buildings_space building_floor_area bgspaflr floorname FALSE TRUE TRUE Name of the building floor
buildings buildings_space building_room_area bgsparom room_id TRUE FALSE FALSE Primary Key
buildings buildings_space building_room_area bgsparom buildng_id FALSE FALSE FALSE FOREIGN KEY - Links the record to BGGENSTR through primary key BUILDNG_ID.
buildings buildings_space building_room_area bgsparom floor_id FALSE FALSE FALSE FOREIGN KEY - Links the record to BGSPALFR through primary key FLOOR_ID
buildings buildings_space building_room_area bgsparom room_ht FALSE FALSE FALSE Height dimension of the building room, measured from floor to ceiling.
buildings buildings_space building_room_area bgsparom room_leng FALSE FALSE FALSE Length dimension of a building room, measured from inside of wall to inside of wall.
buildings buildings_space building_room_area bgsparom room_width FALSE FALSE FALSE Width dimension of a building room, measured from inside of wall to inside of wall.
buildings buildings_space building_room_area bgsparom roomname FALSE TRUE TRUE Name of the building room.
cadastre cadastre_federal_dod_property installation_area cddodins instln_id TRUE FALSE FALSE Primary Key
cadastre cadastre_federal_dod_property installation_area cddodins feat_desc FALSE FALSE FALSE A description of the feature.
cadastre cadastre_federal_dod_property installation_area cddodins inst_desc FALSE FALSE TRUE A description for the installation.
cadastre cadastre_federal_dod_property installation_area cddodins instname FALSE FALSE TRUE Name of the installation.
communications communications_cable_trans communications_coaxial_line coctrox cocoax_id TRUE FALSE FALSE Primary Key
communications communications_cable_trans communications_coaxial_line coctrox feat_name FALSE TRUE FALSE Any commonly used name for the cable.
communications communications_cable_trans communications_fiberoptic_line coctrfop fiberop_id TRUE FALSE FALSE Primary Key
communications communications_cable_trans communications_fiberoptic_line coctrfop feat_name FALSE TRUE FALSE The name of the feature.
communications communications_cable_trans communications_other_type_cable_line coctrocl cother_id TRUE FALSE FALSE Primary Key
communications communications_cable_trans communications_other_type_cable_line coctrocl feat_name FALSE TRUE FALSE Any commonly used name for the cable.
communications communications_cable_trans communications_twisted_pair_line coctrtwp twpcbl_id TRUE FALSE FALSE Primary Key
communications communications_cable_trans communications_twisted_pair_line coctrtwp feat_name FALSE TRUE FALSE The name of the feature.
environmental_hazards env_haz_munitions_remediation munition_waste_disposal_area ehmrmmwd mrmmwd_id TRUE FALSE FALSE Primary Key
environmental_hazards env_haz_munitions_remediation munition_waste_disposal_area ehmrmmwd narrative FALSE TRUE FALSE A description or other unique information concerning the subject item.
environmental_hazards env_haz_munitions_remediation munition_waste_disposal_area ehmrmmwd pit_typ_d FALSE FALSE TRUE Code designated: eg. Open_Detonation, Open_Burn
environmental_hazards env_haz_regulated_tanks regulated_aboveground_storage_tank_site ehtnkast envast_id TRUE FALSE FALSE Primary Key
environmental_hazards env_haz_regulated_tanks regulated_aboveground_storage_tank_site ehtnkast narrative FALSE TRUE TRUE A description or other unique information concerning the subject item.
fauna fauna_management government_wildlife_management_area famgtgov wld_mgt_id TRUE FALSE FALSE Primary Key
fauna fauna_management government_wildlife_management_area famgtgov feat_name FALSE TRUE FALSE Name of the wildlife management area or refuge.
hydrography hydrography_coastal_zone shoreline hycznshr shorln_id TRUE FALSE FALSE Primary Key
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SDS Entity Set SDS Entity Class SDS Entity Type Entity Name SDS Attribute ID Number (Link) Desc Attribute Description
hydrography hydrography_coastal_zone shoreline hycznshr shore_name FALSE FALSE TRUE Common name for the shoreline
improvement improvement_athletic_recreation athletic_court_area imathcrt court_id TRUE FALSE FALSE Primary Key
improvement improvement_athletic_recreation athletic_court_area imathcrt court_name FALSE TRUE FALSE The name of the court area.
improvement improvement_athletic_recreation athletic_court_area imathcrt crt_desig FALSE FALSE TRUE Any local designator for the court.
improvement improvement_athletic_recreation athletic_field_area imathare field_id TRUE FALSE FALSE Primary Key
improvement improvement_athletic_recreation athletic_field_area imathare fld_desig FALSE FALSE TRUE Local identifier for field area.
improvement improvement_athletic_recreation athletic_field_area imathare fld_name FALSE TRUE FALSE The name of the athletic field.
improvement improvement_athletic_recreation bleachers_site imathare field_id TRUE FALSE FALSE Primary Key
improvement improvement_athletic_recreation bleachers_site imathare fld_desig FALSE TRUE FALSE Local identifier for field area.
improvement improvement_athletic_recreation bleachers_site imathare fld_name FALSE FALSE TRUE The name of the athletic field.
improvement improvement_athletic_recreation golf_course_fairway_alignment_line imathgfa alignmt_id TRUE FALSE FALSE Primary Key
improvement improvement_athletic_recreation golf_course_fairway_alignment_line imathgfa hole_no FALSE TRUE FALSE The number of the hole, including course designation, if applicable; e.g. BLUE #12
improvement improvement_athletic_recreation golf_course_putting_green_area imathgfg green_id TRUE FALSE FALSE Primary Key
improvement improvement_athletic_recreation golf_course_putting_green_area imathgfg feat_name FALSE TRUE FALSE The designation of the area, #18 GREEN
improvement improvement_athletic_recreation golf_course_putting_green_area imathgfg hole_no FALSE FALSE TRUE The designation of the hole, including the course if so designated; e.g. #6
improvement improvement_athletic_recreation golf_course_tee_area imathgfg green_id TRUE FALSE FALSE Primary Key
improvement improvement_athletic_recreation golf_course_tee_area imathgfg feat_name FALSE TRUE FALSE The designation of the area, #6 RED TEE
improvement improvement_athletic_recreation golf_course_tee_area imathgfg hole_no FALSE FALSE TRUE The designation of the hole, including the course if so designated; e.g. BLUE #6 or RED #6
improvement improvement_athletic_recreation swimming_pool_area imathpol pool_id TRUE FALSE FALSE Primary Key
improvement improvement_athletic_recreation swimming_pool_area imathpol feat_desc FALSE TRUE FALSE Any brief description of the feature.
improvement improvement_channel_master_plan channel_alignment_boundary_line imcmpchb chnline_id TRUE FALSE FALSE Primary Key
improvement improvement_flood_control dam_site imfdcdam dam_id TRUE FALSE FALSE Primary Key
improvement improvement_flood_control dam_site imfdcdam crs_name FALSE FALSE TRUE The name of the water body in which dam was constructed.
improvement improvement_flood_control dam_site imfdcdam feat_name FALSE TRUE FALSE Any commonly used name for the dam structure.
improvement improvement_general miscellaneous_feature_area imgenmis misarea_id TRUE FALSE FALSE Primary Key
improvement improvement_general miscellaneous_feature_area imgenmis feat_cat FALSE FALSE FALSE Facility category code for the feature.
improvement improvement_general miscellaneous_feature_area imgenmis feat_desc FALSE FALSE TRUE Any brief description of the feature
improvement improvement_general miscellaneous_feature_area imgenmis feat_name FALSE TRUE FALSE The name of the feature
improvement improvement_machinery crane_site immaccrn crane_id TRUE FALSE FALSE Primary Key
improvement improvement_machinery crane_site immaccrn crane_d FALSE FALSE TRUE The type of crane.
improvement improvement_machinery crane_site immaccrn feat_name FALSE TRUE FALSE Any commonly used name for the crane.
improvement improvement_outdoor_recreation boat_ramp_site imrecbtr bt_rmp_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation boat_ramp_site imrecbtr feat_name FALSE TRUE FALSE Name of the recreation feature.
improvement improvement_outdoor_recreation boating_site imrecbot boating_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation boating_site imrecbot feat_desc FALSE FALSE FALSE Any brief description of the feature.
improvement improvement_outdoor_recreation campground_area imceccmp camping_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation campground_area imceccmp feat_name FALSE TRUE FALSE Any commonly used name for the campsite
improvement improvement_outdoor_recreation day_use_area imrecdua dayuse_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation day_use_area imrecdua feat_name FALSE TRUE TRUE The name of the feature.
improvement improvement_outdoor_recreation drive_in_theatre_area imrecdit theatre_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation drive_in_theatre_area imrecdit feat_desc FALSE FALSE FALSE Any brief description of the feature.
improvement improvement_outdoor_recreation fishing_site imrecfsh fishing_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation fishing_site imrecfsh feat_name FALSE TRUE FALSE Any commonly used name for the fishing area.
improvement improvement_outdoor_recreation hunting_area imrechnt hunting_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation hunting_area imrechnt feat_name FALSE TRUE FALSE Any commonly used name for the hunting area.
improvement improvement_outdoor_recreation miscellaneous_recreation_area imrecmis outdoor_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation miscellaneous_recreation_area imrecmis feat_desc FALSE FALSE FALSE Any brief description of the feature.
improvement improvement_outdoor_recreation picnic_site imrecpic picnic_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation picnic_site imrecpic feat_name FALSE TRUE FALSE Any commonly used name for the picnic area.
improvement improvement_outdoor_recreation playground_area imrecply playgnd_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation playground_area imrecply feat_desc FALSE TRUE FALSE Any brief description of the feature.
improvement improvement_outdoor_recreation recreation_park_area imrecprk park_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation recreation_park_area imrecprk feat_name FALSE TRUE FALSE Any commonly used name for the park
improvement improvement_outdoor_recreation small_craft_marina_site imrecmar marina_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation small_craft_marina_site imrecmar feat_name FALSE TRUE FALSE Any commonly used name for the marina.
improvement improvement_outdoor_recreation swimming_site imrecswm swimng_id TRUE FALSE FALSE Primary Key
improvement improvement_outdoor_recreation swimming_site imrecswm feat_name FALSE TRUE FALSE Any commonly used name for the swimming area.
military_operations military_safety ammunition_storage_area mlsftamo storage_id TRUE FALSE FALSE Primary Key
military_operations military_safety ammunition_storage_area mlsftamo stor_desc FALSE FALSE FALSE A description of the ammo storage area.
military_operations military_safety ammunition_storage_area mlsftamo stor_desig FALSE FALSE TRUE Any local designator for the ammo storage area. Area Designator Name
military_operations military_training military_landing_zone_area mltnglzn airsaf_id TRUE FALSE FALSE Primary Key
military_operations military_training training_site mltngtrg trng_id TRUE FALSE FALSE Primary Key
military_operations military_training training_site mltngtrg feat_desc FALSE TRUE FALSE A brief description of the training area.
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military_operations military_training training_site mltngtrg narrative FALSE FALSE TRUE A description or other unique information concerning the subject item.
transportation transportation_air airfield_surface_centerline trairsur air_sur_id TRUE FALSE FALSE Primary Key
transportation transportation_air airfield_surface_centerline trairsur feat_name FALSE TRUE FALSE The name of the feature
transportation transportation_air airfield_surface_centerline trairsur sur_use_d FALSE FALSE TRUE The primary purpose of the surface of the airfield
transportation transportation_air airfield_surface_edge_line trairsur air_sur_id TRUE FALSE FALSE Primary Key
transportation transportation_air airfield_surface_edge_line trairsur feat_name FALSE FALSE TRUE The name of the feature
transportation transportation_air airfield_surface_edge_line trairsur sur_use_d FALSE FALSE FALSE The primary purpose of the surface of the airfield
transportation transportation_air airfield_surface_site trairsur air_sur_id TRUE FALSE FALSE Primary Key
transportation transportation_air airfield_surface_site trairsur feat_name FALSE TRUE FALSE The name of the feature
transportation transportation_air airfield_surface_site trairsur sur_use_d FALSE FALSE TRUE The primary purpose of the surface of the airfield
transportation transportation_marine anchor_berth_area trmaranc maranc_id TRUE FALSE FALSE Primary Key
transportation transportation_marine anchor_berth_area trmaranc dep_dat_d FALSE FALSE TRUE A code indicating the reference or datum used to determine the water depth.
transportation transportation_marine anchor_berth_area trmaranc feat_name FALSE TRUE FALSE Any commonly used name or designator for the anchor berth. Feature Name
transportation transportation_marine anchor_berth_area trmaranc mean_depth FALSE FALSE FALSE The mean depth of water within the anchor berth.
transportation transportation_marine anchorage_area trmaracg anchrg_id TRUE FALSE FALSE Primary Key
transportation transportation_marine anchorage_area trmaracg dep_dat_d FALSE FALSE FALSE A code indicating the reference or datum against which the water depth is measured.
transportation transportation_marine anchorage_area trmaracg feat_name FALSE TRUE FALSE Any commonly used name for the anchorage.
transportation transportation_marine anchorage_area trmaracg mean_depth FALSE FALSE FALSE The mean water depth in the anchorage.
transportation transportation_marine channel_area trmarchn channel_id TRUE FALSE FALSE Primary Key
transportation transportation_marine channel_area trmarchn feat_name FALSE TRUE FALSE Any commonly used name for the channel .
transportation transportation_marine ferry_route_area trmarrte marrte_id TRUE FALSE FALSE Primary Key
transportation transportation_marine ferry_route_area trmarrte ferry_name FALSE FALSE TRUE Any commonly used name
transportation transportation_marine landing_site trmarlnd landing_id TRUE FALSE FALSE Primary Key
transportation transportation_marine landing_site trmarlnd feat_name FALSE TRUE FALSE Any commonly used name for the landing.
transportation transportation_ports_and_harbors drydock_site trhrbdry drydock_id TRUE FALSE FALSE Primary Key
transportation transportation_ports_and_harbors drydock_site trhrbdry facil_id FALSE FALSE FALSE Foreign key, link to the Facility Record
transportation transportation_ports_and_harbors drydock_site trhrbdry feat_name FALSE TRUE FALSE Common name used to identify the drydock area
transportation transportation_ports_and_harbors mooring_facility_site trhrbmor facilty_id TRUE FALSE FALSE Primary Key
transportation transportation_ports_and_harbors mooring_facility_site trhrbmor fac_type_d FALSE FALSE TRUE Discriminator - The type of the mooring facility
transportation transportation_ports_and_harbors mooring_facility_site trhrbmor feat_name FALSE TRUE FALSE Any commonly used name for the mooring area
transportation transportation_ports_and_harbors turning_basin_area trhrbtrn vesturn_id TRUE FALSE FALSE Primary Key
transportation transportation_ports_and_harbors turning_basin_area trhrbtrn feat_name FALSE TRUE FALSE Common name used to identify the turning basin
transportation transportation_railroad railroad_centerline trrrdrcl railrd_id TRUE FALSE FALSE Primary Key
transportation transportation_railroad railroad_centerline trrrdrcl feat_name FALSE FALSE TRUE Any commonly used name for the railroad
transportation transportation_railroad railroad_centerline trrrdrcl traf_vol_d FALSE FALSE FALSE Traffic volume for this segment.
transportation transportation_railroad railroad_yard_area trrrdyrd rryard_id TRUE FALSE FALSE Primary Key
transportation transportation_railroad railroad_yard_area trrrdyrd feat_desc FALSE FALSE TRUE A description of therailroad yard. Feature Descriptive Text
transportation transportation_railroad railroad_yard_area trrrdyrd yard_name FALSE TRUE FALSE A name that represent the railroad yard. Name Descriptive Text
transportation transportation_vehicle road_centerline trvehrcl cline_id TRUE FALSE FALSE Primary Key
transportation transportation_vehicle road_centerline trvehrcl feat_name FALSE FALSE FALSE Any commonly used name for the road centerline.
transportation transportation_vehicle road_centerline trvehrcl road_name FALSE FALSE TRUE A common name or street name used to refer to the stretch of road.
transportation transportation_vehicle road_site trvehrds rd_seg_id TRUE FALSE FALSE Primary Key
transportation transportation_vehicle road_site trvehrds feat_name FALSE FALSE FALSE Any commonly used name or designator.
transportation transportation_vehicle road_site trvehrds road_name FALSE FALSE TRUE Name of the roadway segment
transportation transportation_vehicle vehicle_parking_area trvehprk parking_id TRUE FALSE FALSE Primary Key
transportation transportation_vehicle vehicle_parking_area trvehprk feat_desc FALSE TRUE FALSE Any commonly used name for the parking area. Feature Name
transportation transportation_vehicle vehicle_parking_area trvehprk park_use_d FALSE FALSE TRUE The primary use of the parking area.
transportation transportation_vehicle vehicle_parking_area trvehprk veh_day FALSE FALSE FALSE The average number of vehicles normally parked within the parking area per day.
utilities utilities_compressed_air_system compressed_air_pipe_line utairpip airpipe_id TRUE FALSE FALSE Primary Key
utilities utilities_compressed_air_system compressed_air_pipe_line utairpip feat_desc FALSE FALSE FALSE Any brief description of the feature.
utilities utilities_electrical_system electrical_cable_line utelecgp cblgrp_id TRUE FALSE FALSE Primary Key
utilities utilities_electrical_system electrical_cable_line utelecgp feat_name FALSE TRUE FALSE Any commonly used name for the feature.
utilities utilities_electrical_system electrical_cable_line utelecgp voltage_d FALSE FALSE TRUE The system voltage applied to the cable group.
utilities utilities_electrical_system electrical_substation_site electrical_substation_site substa_id TRUE FALSE FALSE Primary Key
utilities utilities_electrical_system electrical_substation_site electrical_substation_site fac_name FALSE TRUE FALSE The site specific identification name or number assigned to the subject item.
utilities utilities_electrical_system electrical_substation_site electrical_substation_site feat_name FALSE TRUE TRUE Name of the electrical substation site.
utilities utilities_fuel_system fuel_line utfulpip fulpipe_id TRUE FALSE FALSE Primary Key
utilities utilities_fuel_system fuel_line utfulpip use_d FALSE FALSE FALSE Discriminator.  This value differentiates similar entities by use or type.
utilities utilities_fuel_system fuel_tank_site utfultnk tank_id TRUE FALSE FALSE Primary Key
utilities utilities_fuel_system fuel_tank_site utfultnk serial_no FALSE TRUE FALSE unique identification number of the subject item.
utilities utilities_fuel_system fuel_tank_site utfultnk tank_dia FALSE FALSE FALSE The inside diameter of the tank.
utilities utilities_fuel_system fuel_tank_site utfultnk tank_lgth FALSE FALSE FALSE The length dimension of the tank, measured from outside face of the exterior wall/side.
utilities utilities_fuel_system fuel_tank_site utfultnk tank_use_d FALSE FALSE TRUE Discriminator.  This value differentiates similar entities by use or type.
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utilities utilities_fuel_system fuel_tank_site utfultnk tank_width FALSE FALSE FALSE The exterior width dimension of the tank, measured from outside face of the exterior wall/side
utilities utilities_general conduit_centerline utgencon utcond_id TRUE FALSE FALSE Primary Key
utilities utilities_general conduit_centerline utgencon feat_name FALSE TRUE FALSE Any commonly used name of the culvert.
utilities utilities_general undefined_tank_site utgenutk unktnk_id TRUE FALSE FALSE Primary Key
utilities utilities_general undefined_tank_site utgenutk buildng_id FALSE FALSE FALSE Foreign Key to SDS bggenstr Entity.
utilities utilities_general undefined_tank_site utgenutk tank_lgth FALSE FALSE FALSE The length dimension of the tank, measured from outside face of the exterior wall/side.
utilities utilities_general undefined_tank_site utgenutk tank_width FALSE FALSE FALSE The exterior width dimension of the tank, measured from outside face of the exterior wall/side
utilities utilities_general undefined_utility_line utgenpip genpipe_id TRUE FALSE FALSE Primary Key
utilities utilities_general utility_pole_tower_point utgenpol pole_id TRUE FALSE FALSE Primary Key
utilities utilities_general utility_pole_tower_point utgenpol manuf_id FALSE TRUE FALSE An operator generated identifier used to identify a specific manufacturer.
utilities utilities_general utility_pole_tower_point utgenpol poleheight FALSE FALSE FALSE The height of the pole measured from the ground surface to the top.
utilities utilities_head_cool_system heat_cool_line uthcspip hcspipe_id TRUE FALSE FALSE Primary Key
utilities utilities_head_cool_system heat_cool_line uthcspip feat_desc FALSE FALSE FALSE Narrative text providing a brief description of the feature.
utilities utilities_heat_cool_system heat_cool_plant_area uthcsplt hcsplnt_id TRUE FALSE FALSE Primary Key
utilities utilities_heat_cool_system heat_cool_plant_area uthcsplt name_d FALSE TRUE FALSE The site specific identification name or number assigned to the subject item.
utilities utilities_industrial_system industrial_waste_line utinwpip inwpipe_id TRUE FALSE FALSE Primary Key
utilities utilities_industrial_system industrial_waste_line utinwpip use_d FALSE FALSE FALSE Discriminator.  This value differentiates similar entities by use or type.
utilities utilities_industrial_system industrial_waste_oil_water_separator_site utinwsep inwsep_id TRUE FALSE FALSE Primary Key
utilities utilities_industrial_system industrial_waste_oil_water_separator_site utinwsep sep_name FALSE TRUE FALSE The site specific identification name or number assigned to the subject item.
utilities utilities_industrial_system industrial_waste_tank_point utinwtnk inwtank_id TRUE FALSE FALSE Primary Key
utilities utilities_industrial_system industrial_waste_treatment_plant_area utinwtpt inwplnt_id TRUE FALSE FALSE Primary Key
utilities utilities_industrial_system industrial_waste_treatment_plant_area utinwtpt name_d FALSE TRUE FALSE The site specific identification name or number assigned to the subject item.
utilities utilities_natural_gas_system natural_gas_line utgaspip gaspipe_id TRUE FALSE FALSE Primary Key
utilities utilities_natural_gas_system natural_gas_line utgaspip use_d FALSE FALSE FALSE Discriminator.  This value differentiates similar entities by use or type.
utilities utilities_natural_gas_system natural_gas_tank_point utgastnk gastank_id TRUE FALSE FALSE Primary Key
utilities utilities_natural_gas_system natural_gas_tank_point utgastnk tank_dia FALSE FALSE FALSE The inside diameter of the tank.
utilities utilities_natural_gas_system natural_gas_tank_point utgastnk tank_lgth FALSE FALSE FALSE The length dimension of the tank, measured from outside face of the exterior wall/side.
utilities utilities_natural_gas_system natural_gas_tank_point utgastnk tank_use_d FALSE FALSE FALSE The particular kind or use of the tank.
utilities utilities_natural_gas_system natural_gas_tank_point utgastnk tank_width FALSE FALSE FALSE The exterior width dimension of the tank, measured from outside face of the exterior wall/side
utilities utilities_saltwater_system saltwater_line utswtpip swtline_id TRUE FALSE FALSE Primary Key
utilities utilities_saltwater_system saltwater_line utswtpip feat_desc FALSE FALSE FALSE Any brief description of the feature.
utilities utilities_storm_system storm_sewer_line utstopip stopipe_id TRUE FALSE FALSE Primary Key
utilities utilities_storm_system storm_sewer_line utstopip feat_name FALSE FALSE FALSE Narrative text providing a brief description of the feature.
utilities utilities_storm_system storm_sewer_line utstopip use_d FALSE FALSE FALSE Discriminator.  This value differentiates similar entities by use or type.
utilities utilities_transmission_system pipeline_line uttxspip txpipe_id TRUE FALSE FALSE Primary Key
utilities utilities_wastewater_system wastewater_disposal_tank_site utwwttnk wwtank_id TRUE FALSE FALSE Primary Key
utilities utilities_wastewater_system wastewater_disposal_tank_site utwwttnk tank_dia FALSE FALSE FALSE The inside diameter of the tank.
utilities utilities_wastewater_system wastewater_disposal_tank_site utwwttnk tank_lgth FALSE FALSE FALSE The length dimension of the tank, measured from outside face of the exterior wall/side.
utilities utilities_wastewater_system wastewater_disposal_tank_site utwwttnk tank_use_d FALSE FALSE FALSE The particular kind or use of the waste water tank.
utilities utilities_wastewater_system wastewater_disposal_tank_site utwwttnk tank_width FALSE FALSE FALSE The exterior width dimension of the tank, measured from outside face of the exterior wall/side
utilities utilities_wastewater_system wastewater_line utwwtpip pipe_id TRUE FALSE FALSE Primary Key
utilities utilities_wastewater_system wastewater_line utwwtpip use_d FALSE FALSE FALSE The status of the subject item, The status of the subject item.
utilities utilities_wastewater_system wastewater_treatment_plant_site utwwttpt wwtplnt_id TRUE FALSE FALSE Primary Key
utilities utilities_wastewater_system wastewater_treatment_plant_site utwwttpt name_d FALSE TRUE FALSE The site specific identification name or number assigned to the subject item.
utilities utilities_water_system water_line utwatpip watpipe_id TRUE FALSE FALSE Primary Key
utilities utilities_water_system water_line utwatpip use_d FALSE FALSE FALSE Discriminator.  This value differentiates similar entities by use or type.
utilities utilities_water_system water_tank_site utwattnk wattank_id TRUE FALSE FALSE Primary Key
utilities utilities_water_system water_tank_site utwattnk serial_no FALSE TRUE FALSE unique identification number of the subject item.
utilities utilities_water_system water_tank_site utwattnk tank_dia FALSE FALSE FALSE The inside diameter of the tank.
utilities utilities_water_system water_tank_site utwattnk tank_lgth FALSE FALSE FALSE The length dimension of the tank, measured from outside face of the exterior wall/side.
utilities utilities_water_system water_tank_site utwattnk tank_use_d FALSE FALSE TRUE Discriminator.  This value differentiates similar entities by use or type.
utilities utilities_water_system water_tank_site utwattnk tank_width FALSE FALSE FALSE The exterior width dimension of the tank, measured from outside face of the exterior wall/side
utilities utilities_water_system water_treatment_plant_area utwattpt watplnt_id TRUE FALSE FALSE Primary Key
utilities utilities_water_system water_treatment_plant_area utwattpt name_d FALSE TRUE FALSE The site specific identification name or number assigned to the subject item.
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